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Preface

Welcome to the Essbase Administration Services Installation Guide:

● “Purpose” on page vii

● “Audience” on page vii

● “Document Structure” on page viii

● “Where to Find Documentation” on page viii

● “Conventions” on page x

● “Additional Support” on page xii

● “Documentation Feedback” on page xii

Purpose
This guide provides you with information that you need to install Essbase 
Administration Services and to start it for the first time. It explains Administration 
Services deployment options and contains the concepts, processes, and procedures 
that you need to install the software.

Audience
This book is for Essbase system administrators who need to install and configure 
Administration Services software on Windows or UNIX platforms. It also assists 
system administrators in deciding how to deploy Administration Services with 
Analytic Servers in an enterprise environment. 
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Document Structure
This document contains the following information: 

● Chapter 1, “Overview and Deployment,” provides an overview of the 
Administration Services architecture and deployment options.

● Chapter 2, “Planning the Installation,” lists installation prerequisites and 
system requirements for Administration Services.

● Chapter 3, “Installing Administration Services,” explains how to install 
Administration Services.

● Chapter 4, “Upgrading to This Release,” describes the process for upgrading 
from previous releases of Administration Services.

● Chapter 5, “Working with Administration Services,” provides procedures for 
getting started with and using Administration Services.

● Chapter 6, “Implementing the Hyperion Security Platform,” explains how to 
set up Analytic Services and Administration Services to use external 
authentication supplied by the Hyperion security platform.

● Chapter 7, “Configuring Third-Party Components,” describes how to 
configure third-party components for use with Administration Services.

● Index contains a list of Administration Services terms and their page 
references.

Where to Find Documentation
All Administration Services documentation is accessible from the following 
locations:

● The HTML Information Map is located at

EASPATH\eas\doc_launcher.htm

Launch this file, and then provide the name of the computer where 
Administration Server is installed. Administration Server must be started 
when you launch the Information Map.

● The Help menu in Administration Services Console provides access to most 
documentation.
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● The Hyperion Solutions Web site is located at

http://www.hyperion.com

● Access to the Hyperion Download Center is through

http://hyperion.subscribenet.com

➤ To access documentation through the Hyperion Solutions Web site:

1. Log on to http://www.hyperion.com.

2. Select the Support link and type your username and password to log on.

Note: New users must register to receive a username and password.

3. Click the Hyperion Download Center link and follow the on-screen 
instructions.

➤ To access documentation from the Hyperion Download Center:

1. Log on to http://hyperion.subscribenet.com.

2. In the Login ID and Password text boxes, enter your assigned login ID name 
and password.

3. In the Language list box, select the appropriate language and click Login.

4. If you are a member on multiple Hyperion Download Center accounts, select 
the account that you want to use for the current session.

5. Perform one of the following actions:

● To access documentation online, from the Product List, select the 
appropriate product and follow the on-screen instructions.

● To order printed documentation, from the Information section in the left 
frame, select Order Printed Documentation and follow the on-screen 
instructions.

➤ To order printed documentation if you do not have access to the Hyperion 
Download Center:

● In the United States, call Hyperion Solutions Customer Support at 
877-901-4975.

● From outside the United States, including Canada, call Hyperion Solutions 
Customer Support at 203-703-3600. Clients who are not serviced by support 
from North America should call their local support centers.

http://www.hyperion.com
http://hyperion.subscribenet.com
http://www.hyperion.com
http://hyperion.subscribenet.com


x ■

Preface

Essbase Administration Services Installation Guide

Conventions
This book uses several formatting styles to indicate actions that you should take or 
types of information that you need. Table i lists each document convention:

Table i: Document Conventions 

Example Description

➤ Arrows indicate the beginning of a procedure consisting 
of sequential steps.

Bold Bold in procedural steps highlights major interface 
elements.

Ctrl+0 Keystroke combinations shown with the plus symbol (+) 
indicate that you should press the first key and hold it 
while you press the next key. Do not type the + symbol.

Example text Courier font indicates that the material shown is a code or 
syntax example. Names of files and directories are also 
displayed in this font.

Courier italics Courier italic text indicates a variable field in command 
syntax. Substitute a value in place of the variable shown in 
Courier italics.

ARBORPATH • If Analytic Services is installed on the same computer, 
this environment variable is set to the directory path of 
the Analytic Services installation. The default is 
c:\hyperion\essbase on Windows platforms and 
/home/hyperion/essbase on UNIX platforms. 

• If Analytic Services is not installed on the same 
computer, this environment variable is set internally 
when you start Administration Server. For more 
information about ARBORPATH, see “Starting 
Administration Server” on page 54. 

When you see the environment variable ARBORPATH in 
italics, substitute the value of ARBORPATH from your site.
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EASPATH This is the directory path of the Administration Services 
installation. The default is c:\hyperion on Windows 
platforms and /home/hyperion on UNIX platforms.

On Windows, EASPATH is also a system environment 
variable.

In this document, when you see EASPATH in italics, 
substitute the appropriate directory path from your site.

HYPERION_HOME The environment variable HYPERION_HOME points to the 
directory in which common files used by Administration 
Services and other Hyperion products are installed on 
Windows. The default for HYPERION_HOME is 
c:\hyperion.

Italics Titles of books and online help systems are displayed in 
italics. Italics also indicate important terms and special 
emphasis.

Mouse orientation This document provides examples and procedures using a 
right-handed mouse. If you use a left-handed mouse, 
adjust the procedures accordingly.

Menu options Options in menus are shown in the following format. 
Substitute the appropriate option names in the 
placeholders, as indicated.

Menu name > Menu command > Extended menu 
command 

For example: 1. Select File > Desktop > Accounts. 

Table i: Document Conventions (Continued)

Example Description
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Additional Support
In addition to providing documentation and online help, Hyperion offers the 
following product information and support. For details on education, consulting, 
or support options, visit the Hyperion Solutions Web site at 
http://www.hyperion.com.

Education Services
Hyperion offers instructor-led training, custom training, and eTraining covering all 
Hyperion applications and technologies. Training is geared to administrators, end 
users, and information systems (IS) professionals. 

Consulting Services
Experienced Hyperion consultants and partners implement software solutions 
tailored to clients’ particular reporting, analysis, modeling, and planning 
requirements. Hyperion also offers specialized consulting packages, technical 
assessments, and integration solutions.

Technical Support
Hyperion provides enhanced electronic-based and telephone support to clients to 
resolve product issues quickly and accurately. This support is available for all 
Hyperion products at no additional cost to clients with current maintenance 
agreements.

Hyperion Developer Network
Hyperion Developer Network is your one-stop community destination for all 
things Essbase. Visit http://dev.hyperion.com.

Documentation Feedback
Hyperion strives to provide complete and accurate documentation. We value 
your opinions on this documentation and want to hear from you. Send us your 
comments by clicking the link for the Documentation Survey, which is located on 
the Information Map for your product.

http://www.essbase.com
http://www.hyperion.com
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1

Chapter

1
Overview and Deployment

This chapter introduces you to Essbase Administration Services and explains how 
to deploy this administration tool.      

● “About Essbase Administration Services” on page 13

● “Components of Administration Server” on page 15

● “Deployment of Administration Services” on page 16

● “Accessing Deployment Servers from Administration Services” on page 20

About Essbase Administration Services
Essbase Administration Services is the cross-platform framework for managing 
and maintaining Hyperion Essbase. Administration Services provides a single 
point of access for viewing, managing, and maintaining Analytic Servers, 
Administration Servers, and Deployment Servers. This product provides the 
following: 

● The functionality of Application Manager

● Additional administrative features not provided with Application Manager

● An interface for Analytic Services administration tools, such as MaxL

● A framework for plug-in components

● Administration of Essbase Deployment Servers
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Administration Services consists of two components:

● Administration Services Console (client tier)

This component is a Java client console that enables administrators to manage 
the Analytic Services environment from a robust graphical user interface.

● Administration Server (middle tier) 

This component is a Java middle-tier server that communicates with both 
Administration Services Console and Analytic Servers. Administration Server 
maintains communication and session information for each connection to 
Analytic Servers. Administration Server also stores documentation files so 
that console users can access documentation without having to install it 
locally. 

Administration Server serves as the middle tier between Administration Services 
Console and Analytic Servers, as shown in Figure 1. 

Figure 1: Essbase Administration Services Architecture

These three tiers can be installed on different computers or platforms. For 
deployment scenarios and details, see ““Deployment of Administration Services” 
on page 16.” 
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Components of Administration Server
Administration Server requires the following third-party components:

● A relational database management system (RDBMS)

● An application server

● Java Runtime Environment (JRE)

By default, all of the components you need to run Administration Services are 
automatically installed by the Administration Services installer program. This 
release also supports the substitution of certain third-party products within the 
existing framework.

Relational Database Management System (RDBMS)
Administration Server requires a relational database for storage of Log Analyzer 
information. For information about which databases are supported, and for 
instructions to substitute a third-party database, see “Enabling Support for 
Third-Party Databases” on page 76.

Application Server
Administration Server requires an application server, which provides the business 
logic for Administration Services. For information about which application 
servers are supported, and for instructions to substitute a third-party application 
server, see “Deploying Administration Server on Third-Party Application 
Servers” on page 79.

Java Runtime Environment (JRE)
Administration Services is a Java application and therefore requires a Java 
Runtime Environment (JRE) to execute the program. This release requires JRE 
version 1.4.1 and installs this version automatically on all platforms. For specific 
information about Java requirements, see “System Requirements” on page 24.
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Deployment of Administration Services
This section describes how to deploy Administration Services with Analytic 
Servers. For information about deploying Administration Services with 
Deployment Servers, see “Accessing Deployment Servers from Administration 
Services” on page 20.

You can install Administration Services on the same computer as Analytic Server 
or on a different computer, in various configurations. For example, you can install 
Analytic Server on a computer running UNIX and install Administration Server 
and Administration Services Console on a computer running Windows. You can 
also install Administration Server and Administration Services Console on 
separate computers and platforms. For a list of supported platforms for each 
component, see “System Requirements” on page 24. 

Refer to the following topics when considering deployment:

● “Deployment Scenarios” on page 16

● “Deployment and Configuration Guidelines” on page 19

Deployment Scenarios
Essbase components can be installed in many deployment scenarios. The best 
configuration depends on your organizational requirements and on which release 
of Analytic Server you are using. Before selecting a deployment scenario, read the 
information in “Deployment and Configuration Guidelines” on page 19.
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Here are a few deployment scenarios to consider:

● Administration Server on one computer, Analytic Server on a separate 
computer, and Administration Services Console on one or more client 
computers, as shown in Figure 2

Figure 2: Multiple Servers and Multiple Clients

You can also have multiple Administration Server computers and multiple 
Analytic Server computers, each running on a different platform. Consider 
this configuration if you have multiple administrators working with large 
outlines and Analytic Server has limited resources, or if you will be 
administering large outlines during heavy Analytic Services usage, such as 
querying or building databases.
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● Everything on one computer, as shown in Figure 3

Figure 3: Single Computer

Consider this configuration if you have limited resources or if you need to 
perform administration tasks from the computer hosting Analytic Server. See 
“Deployment and Configuration Guidelines” on page 19 for important 
requirements for this scenario.

● Analytic Server and Administration Server on one computer, and 
Administration Services Console on one or more client computers, as shown 
in Figure 4

Figure 4: Single Server Computer, Multiple Clients
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Each computer can run on a different platform. Consider this configuration if 
you have limited resources but need to administer Analytic Servers from 
multiple locations.

Deployment and Configuration Guidelines
This topic discusses guidelines to consider when choosing a deployment scenario 
and configuring the Administration Server computer.

Administration Server and Administration Services Console should be installed on 
the same computer only if the following requirements are met:

● You want to run Administration Server on a Windows platform. 
(Administration Services Console is supported only on Windows platforms).

● Only one administrator uses Administration Services to manage small-sized 
Analytic Server installations. (As an example, a small-sized Analytic Server 
installation includes fewer than 10 applications, each of which contains fewer 
than 1000 users, fewer than 1000 filters per database, and no scripts larger than 
1 MB).

● The computer has the required amount of memory for both components. For 
detailed memory requirements, see “System Requirements” on page 24. 

● Outline editing is carefully monitored. Outline editing consumes memory on 
both Administration Server and Administration Services Console. Consider 
how many outlines are being edited simultaneously and how large the outlines 
are. For detailed outline memory requirements for Administration Server, see 
Table 3 on page 27. For detailed outline memory requirements for 
Administration Services Console, see Table 6 on page 30. 

In all other cases, Administration Server and Administration Services Console 
should be installed on separate computers. The configuration of the 
Administration Server computer depends upon the potential workload of 
Administration Server. Use the following guidelines when configuring the 
Administration Server computer:

● Administration Server is a single process and can address only 2 GB of 
memory; therefore, it runs out of memory if users are simultaneously editing 
outlines. Consider deploying multiple instances of Administration Server if 
users will be editing multiple outlines simultaneously.
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● If more than 10 users will be connected to Administration Server 
simultaneously, consider (1) using a computer that employs multiple CPUs for 
Administration Server or (2) deploying multiple instances of Administration 
Server on separate computers to improve performance.

Note: For detailed information on memory requirements for Administration Server and 
Administration Services Console, see “System Requirements” on page 24.

Accessing Deployment Servers from 
Administration Services

You can use Administration Services Console to manage Essbase databases that 
are connected through Essbase Deployment Servers. You must install, configure, 
and start the Deployment Servers separately from Administration Services. For 
information about how to install and configure Deployment Servers, see Essbase 
Deployment Services Installation Guide. 

Each Administration Services user can add the appropriate Deployment Servers to 
the Enterprise View tree in Administration Services Console. The added 
Deployment Servers are listed under the Essbase Deployment Servers node in 
Enterprise View. For instructions about adding and managing Deployment 
Servers, see Essbase Administration Services Online Help. 

You can install Administration Services on the same computer as Deployment 
Server or on a different computer, in various configurations. Deployment Servers 
can be configured for TCP/IP or HTTP operation; both modes can be managed 
through Administration Services. For information about which versions of 
Deployment Server are supported, see “Release Compatibility” on page 24.

For information about how to install and configure Deployment Servers, see 
Essbase Deployment Services Installation Guide.
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2

Chapter 

2
Planning the Installation

This chapter provides an overview of the installation process and specifies 
the hardware, operating system, and software requirements for Essbase 
Administration Services.

● “Workflow for Installation” on page 21

● “Product Components” on page 23

● “Prerequisites” on page 23

● “System Requirements” on page 24

Workflow for Installation
Use the following process to install Administration Services and to set up users. 

1. Install a supported release of Analytic Server. 

See “Release Compatibility” on page 24.

If you are installing Analytic Server simultaneously with Administration 
Services, you can install the two products in any order. Administration 
Services deploys its own set of Essbase .dlls and sets ARBORPATH internally, 
so there is no dependency on an existing Analytic Server installation. 
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2. Prepare to install Administration Services:

● Verify that you have all necessary software and documentation. See 
“Product Components” on page 23.

● Decide how you want to deploy Administration Services. You can install 
Administration Services and Analytic Services on different computers or 
platforms. See “Deployment of Administration Services” on page 16.

● Decide if you want to use a supported third-party relational database 
and/or application server instead of the default products provided with the 
installation. See “Configuring Third-Party Components” on page 75.

● Ensure that you have met installation prerequisites, as described in 
“Prerequisites” on page 23.

● Confirm that your platform is supported by Administration Services and 
that system requirements are met for the computer on which you are 
installing. See “System Requirements” on page 24.

3. If upgrading from a previous release of Administration Services, review the 
procedures for upgrading to this release. 

See “Upgrading to This Release” on page 49.

4. Install Administration Services. 

See “Installing Administration Services” on page 33.

5. Start Administration Services. 

See “Starting Administration Services” on page 53.

6. Set up Administration Services users. 

See “Setting Up Users” on page 59.

7. Make a backup copy of the files used to store Administration Services user 
information. 

See “Backing Up and Restoring User Information” on page 60.

8. Specify an outgoing mail (SMTP) server on Administration Server. 

See “Setting Up an SMTP Server” on page 60.
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Product Components
Before you install Administration Services, confirm that you have all necessary 
product components:

● The appropriate self-extracting download files from Hyperion Download 
Center or the CD

● This book, the Essbase Administration Services Installation Guide 

● The Essbase Administration Services Installation Checklist 

● The Essbase Administration Services Readme File 

Prerequisites
Before installing Administration Services, make sure that you have met the 
following prerequisites:

● On UNIX platforms, if the HYPERION_HOME environment variable is already 
defined from a previous Hyperion product installation on the machine to 
which you are installing, ensure that it is set before launching the 
Administration Services installer. HYPERION_HOME is where common 
components are installed during some Hyperion product installations. If the 
HYPERION_HOME environment variable already exists on the computer to 
which you are installing, setting the environment before launching the 
installer will ensure that the appropriate components are installed to the 
existing location of HYPERION_HOME. You must install common components 
to the same location as the existing HYPERION_HOME setting. For more 
information about HYPERION_HOME, see “What Happens During Installation” 
on page 37.

● If you plan to deploy Administration Server on a supported third-party 
application server, you must install the application server first and then install 
Administration Server on the computer hosting the application server. For 
more information, see “Deploying Administration Server on Third-Party 
Application Servers” on page 79.

● Be aware of existing port usage so that you can resolve port conflicts during 
installation. For more information about configurable ports, see “Specifying 
Communication Ports for Apache Tomcat” on page 58.

● If you plan to use external authentication, see the requirements in Chapter 6, 
“Implementing the Hyperion Security Platform.”
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System Requirements
Use the tables in the following topics to verify that this release supports the 
platforms where you plan to install Administration Services:

● “Release Compatibility” on page 24

● “Supported Platforms for Administration Server” on page 25

● “System Requirements for Administration Server” on page 26

● “Supported Platforms for Administration Services Console” on page 29

● “System Requirements for Administration Services Console” on page 29

Release Compatibility
Use these topics for release compatibility information:

● “Supported Analytic Server Releases” on page 24

● “Supported Deployment Server Releases” on page 25

● “Administration Server and Administration Services Console Compatibility” 
on page 25

Supported Analytic Server Releases
Administration Services supports the following releases of Analytic Server:   

● Release 6.5.1

● Release 6.5.2 (Linux platform release for Analytic Server)

● Release 6.5.3

● Release 6.5.4

● Release 7.0

● Release 7.1

Note: Administration Services does not support Analytic Server Release 6.5.0.

Although you can use Administration Services to connect to an earlier release of 
Analytic Server, you cannot use the features introduced in later releases of 
Analytic Server. 
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Supported Deployment Server Releases
Administration Services supports Deployment Server Release 7.1 or higher. 

Administration Server and Administration Services 
Console Compatibility
When you upgrade to a new release of Administration Services, you must upgrade 
both Administration Server and Administration Services Console. 

Supported Platforms for Administration Server
Table 1 lists the supported platforms for this release of Administration Server.

Updated C++ Runtime Environment for AIX 5L
If the following error message is displayed on AIX, you need to install an updated 
C++ runtime environment on that computer:

exec(): 0509-036 Cannot load program ESSBASE because 
of the following errors: 0509-150 Dependent module 
/usr/lib/libC.a(shrcore.o) could not be loaded. 
0509-152 Member shrcore.o is not found in archive 

Table 1: Administration Server Supported Platforms 

Platforms Supported Versions

AIX 5L (V5.1 or V5.2) on PowerPC computers, including RS 6000

• An updated C++ runtime environment is required. 

• For 5.1: ML1 and ML 4 are not supported.

• For 5.2: The minimum supported level is 5.2 ML 1.

HP-UX 11.0 and 11i on PA-RISC computers running HP-UX 
kernel-threads

Linux RedHat Linux AS 2.1 for Intel

Solaris 2.8 or 2.9 (SUN OS 5.8 or 5.9)

Windows Windows 2000 SP3

Windows 2003
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➤ To download this file:

1. Go to the IBM technical support website:

https://techsupport.services.ibm.com/ 

2. Search for the PTF number (U489780) or the fileset (xlC.aix50.rte.6.0.0.7).

3. Download the file.

System Requirements for Administration Server
Table 2 lists the system requirements for the computer where Administration 
Server is installed. 

 

Table 2: Administration Server System Requirements    

Component Requirement

Disk space 180 MB minimum

This estimate includes documentation files and all 
Hyperion common components. The installer program 
calculates the exact amount of required disk space, based 
on your installation choices. 

Allow extra disk space for data files and outline files that 
are copied to Administration Server during data loads and 
outline editing, respectively.

RAM See Table 3 on page 27.

Network protocol TCP/IP

Java platform  Java Runtime Environment Version 1.4.1 (installed 
automatically on all platforms)

RDBMS1 Choose one of the following:

• MySQL 4.0.12PRO

• Oracle 8i and 9i

• IBM DB2 7.2 and 8.1

Note: Oracle and DB2 databases do not have to be 
installed on the same computer as Administration Server.

https://techsupport.services.ibm.com/
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The following table lists detailed memory requirements for Administration Server. 

Application server2 Choose one of the following:

• Apache Tomcat Server 4.1.30

• BEA WebLogic Server 8.1

• IBM WebSphere Application Server 5.1

ESSLANG 
environment variable

The installation program prompts you to select a value for 
ESSLANG, which points Administration Server to the 
correct Global C code page.

For detailed information about what you should select for 
the ESSLANG value, see “Selecting the ESSLANG Value” 
on page 46.

1 If you choose, the correct version of MySQL is installed and configured for use with 
Administration Services. For information about enabling support for third-party databases, 
see “Enabling Support for Third-Party Databases” on page 76.

2 If you choose, the correct version of Apache Tomcat Server is installed and configured for 
use with Administration Services. For information about deploying Administration Server 
on a supported third-party application server, see “Deploying Administration Server on 
Third-Party Application Servers” on page 79.

Table 3: Detailed Memory Requirements for Administration Server 

Component Requirement Discussion

Startup memory 38 MB Startup memory consists of:

16 MB initial heap + 22 MB for code

Working memory 32 MB * number of 
concurrent 
Administration 
Server users

For example:

When 10 administrators are connected to 
Administration Server:

32 MB * 10 = 320 MB 

Table 2: Administration Server System Requirements (Continued)   

Component Requirement
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Outline memory 1 KB per member for 
outlines open in Outline 
Editor

This memory is used by the outline API cache 
when outlines are opened in Outline Editor.

-Xmx parameter in 
adminsvr.lax 

Default value = 128 MB

Recommended value = 
initial heap memory + 
working memory

This parameter is in the following file:

EASPATH\eas\server\bin\
adminsvr.lax 

in the “lax.nl.java.option.additional” section.

The -Xmx parameter controls the maximum 
memory available to Administration Server 
(excluding outline memory), which is limited 
by the physical memory available on the 
operating system. 

It is recommended that you calculate the 
appropriate value for this parameter using the 
following formula:

initial heap memory + working memory

For example:

16 MB + (32 MB * n) where n = number of 
concurrent Administration Server users

Table 3: Detailed Memory Requirements for Administration Server (Continued)

Component Requirement Discussion
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Supported Platforms for Administration Services Console
Table 4 lists the supported platforms for this release of Administration Services 
Console.

System Requirements for Administration Services 
Console

Table 5 lists the system requirements for the computer where Administration 
Services Console is installed.

 

Table 4: Administration Services Console Supported Platforms 

Platforms Supported Versions

Windows • Windows XP

• Windows 2000 SP3

• Windows 2003

Table 5: Administration Services Console System Requirements   

Component Requirement

Disk space 90 MB minimum

Note: The installer program calculates the exact amount 
of required disk space, based on your installation choices.

RAM See Table 6 on page 30.

Network protocol TCP/IP

Java platform Java Runtime Environment Version 1.4.1 (installed 
automatically on all platforms)

Screen resolution 1024 x 768
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The following table lists detailed memory requirements for Administration 
Services Console:

Table 6: Detailed Memory Requirements for Administration 
Services Console 

Component Requirement Discussion

Startup memory 33 MB Startup memory consists of:

8 MB initial heap + 25 MB for code

Working memory 64 MB1 per connected 
Analytic Server

For example:

64 MB * 3 (connected Analytic Servers) = 
192 MB

Analytic Servers that are listed in Enterprise 
View but are not connected do not use 
memory. Administration Services Console 
caches most of the information retrieved from 
Analytic Server until the user disconnects from 
Analytic Server. Examples of information kept 
in cache include

• application list

• database list

• user list

• filter list

• group list

• open calculation scripts, report scripts, and 
MaxL scripts

To reduce memory usage, close unnecessary 
instances of script editors.



System Requirements

2

■ 31Essbase Administration Services Installation Guide

Outline memory Outline Editor:

32 MB + (500 B per 
member)

In Outline Editor, a maximum of 5,000 level-0 
members per parent are retrieved into memory:

• Non-level-0 members are retained in 
memory.

• Memory is not released for members that 
are modified during the editing session. For 
example, deleted or renamed members are 
retained in memory. 

For example, if the outline has 1,000 
non-level-0 members and 100,000 level-0 
members, then memory usage would be:

33,554,432 + (500 * 1,000) + (500 * 5,000) = 
36,554,432 B 

Outline Viewer:

32 MB + (8 B * number 
of  visible members)

In Outline Viewer, a member is considered 
“visible” if its parent is expanded.

For example, if the outline has 1,000 
non-level-0 members and 100,000 level-0 
members, then memory usage would be:

33,554,432 + (8 * 101,000) = 34,362,432 B

-Xmx parameter in 
admincon.lax 

Default value = 256 MB

Recommended value =
initial heap memory + 
working memory + 
outline memory

This parameter is in the following file:

EASPATH\eas\console\bin\
admincon.lax 

in the “lax.nl.java.option.additional” section. 

The -Xmx parameter controls the maximum 
memory available to Administration Services 
Console.

It is recommended that you calculate the 
appropriate value for this parameter using the 
following formula:

initial heap memory + working memory + 
outline memory

1 For small-sized Analytic Services installations, working memory can be reduced to 32 MB per connected 
Analytic Server. For an example of a small-sized installation, see “Deployment and Configuration 
Guidelines” on page 19.

Table 6: Detailed Memory Requirements for Administration 
Services Console (Continued)

Component Requirement Discussion
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3

Chapter

3
Installing Administration 
Services

This chapter provides instructions for installing Administration Services on all 
platforms and describes what happens during the installation process. 

This chapter includes the following topics:

● “Launching Installers” on page 34

● “Launching Installers on UNIX” on page 35

● “Installing Administration Services Software” on page 35

● “What Happens During Installation” on page 37

● “Running Administration Server as a Windows Service” on page 42

● “Selecting the ESSLANG Value” on page 46

● “Uninstalling Administration Services” on page 47

Before you begin installation, read and follow the instructions outlined in 
Chapter 2, “Planning the Installation.”
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Launching Installers
Before installing Administration Services, decide which software installation 
format you will use. You can install from files that you have downloaded from the 
Hyperion Download Center or from a CD. 

➤ To launch the Administration Services installer from the appropriate 
self-extracting download file from the Hyperion Download Center:

1. Log on to the Hyperion Download Center.

2. Navigate to the Administration Services product page from the list provided.

3. Download the Start Here document for instructions on downloading the 
installer files.

4. Run the appropriate installer. 

Note: For information about launching UNIX installers, see “Launching Installers 
on UNIX” on page 35.

➤ To launch the Administration Services installer from the CD:

1. Navigate to the eas directory on the CD.

2. Navigate to the appropriate directory for your platform.

3. Run the appropriate installer for your platform:

● setup.exe for Windows

● setup.bin for UNIX

Note: For information about launching UNIX installers, see “Launching Installers on 
UNIX” on page 35.
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Launching Installers on UNIX
On UNIX platforms, you can launch the installer from the console or in 
XWindows. 

➤ To launch the installer in XWindows, type:

./installer file name 

For example:

./setup.bin

➤ To launch the installer in the console, type:

./installer file name -console 

For example:

./setup.bin -console 

Installing Administration Services Software
Administration Services provides a cross-platform installer program for both 
Windows and UNIX platforms.

You can access the installer program from the appropriate self-extracting 
download files at the Hyperion Download Center or from the CD. To make the 
installer program available to users who do not have access to Hyperion Download 
Center or the CD, download the program to a network. 

Note: You can leave Analytic Server running while installing Administration Services.

➤ To install Administration Services:

1. Verify that all prerequisites and system requirements are met. 

For detailed information, see Chapter 2, “Planning the Installation.”

2. Download and launch the applicable installer program for the Administration 
Services software. 

See “Launching Installers” on page 34 for instructions.
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3. Follow the installation prompts, keeping in mind the following information: 

● You can install Administration Services to any directory except a 
directory that contains a space in the directory name (for example, 
c:\Program Files). The default directory is c:\hyperion. 

● Hyperion common components are installed to a different directory than 
the Administration Services software: HYPERION_HOME\common. The 
default location for HYPERION_HOME is c:\hyperion. Once defined, 
the location for HYPERION_HOME cannot be changed.

The location for common components is defined in the HYPERION_HOME 
system variable. On Windows platforms, if the HYPERION_HOME system 
variable already exists, the Administration Services installer places 
common components in the existing HYPERION_HOME location. On 
UNIX platforms, if the HYPERION_HOME system variable already exists, 
you must set the environment before launching the installer to ensure that 
common components are installed to the existing location of 
HYPERION_HOME. 

For more information about HYPERION_HOME, see “Files Installed in the 
HYPERION_HOME Directory” on page 40.

● A typical installation installs Administration Server and Administration 
Services Console components and the documentation. A custom 
installation enables you to install Administration Server and 
Administration Services Console components separately.

● You can choose to install the default middle-tier relational database 
(MySQL), or you can choose not to install MySQL if you plan to use a 
supported third-party database instead. If you choose to install MySQL, 
you must specify a port number and location or accept the defaults. The 
standard port used to communicate with MySQL is port 3306. This port 
must be available when you start Administration Server.  

If you do not know what information to specify, see your administrator for 
the database you are substituting. The relational database is used only to 
store Log Analyzer information. For more information about MySQL, see 
“What Happens During Installation” on page 37. For more information 
about third-party databases, see “Enabling Support for Third-Party 
Databases” on page 76.

● You can choose to install the default middle-tier application server 
(Apache Tomcat), or you can choose not to install Apache Tomcat if you 
plan to use a supported third-party application server instead. If you 
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choose to install Apache Tomcat, you must specify port numbers to use or 
accept the defaults. For more information about Apache Tomcat, see 
“What Happens During Installation” on page 37. 

For instructions about deploying to a supported third-party application 
server, see “Deploying Administration Server on Third-Party Application 
Servers” on page 79.  

● On Windows platforms, you can install Administration Server as a 
Windows service. For instructions, see “Installing Administration Server 
as a Windows Service” on page 43.

● The installer prompts you to select a value for the ESSLANG environment 
variable. The default value for the ESSLANG variable is English (Latin1). 
For detailed information about what you should select for the ESSLANG 
variable, see “Selecting the ESSLANG Value” on page 46.

After installation is complete, you can start Administration Services and create 
users. See “Working with Administration Services” on page 53. 

What Happens During Installation
During installation, the Administration Services installer program performs the 
following operations:

● Creates the \eas directory and subdirectories under the location you specify 
in the installer 

The directory where you install Administration Services is referred to as the 
EASPATH directory. For a listing of the Administration Services directories 
created, see “Files Installed in the EASPATH Directory” on page 39.

● On Windows, creates the EASPATH environment variable on the system 

EASPATH is set to the root directory of the Administration Services installation 
(for example, c:\hyperion).
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● Installs Hyperion common components to the HYPERION_HOME\common 
directory

Some third-party common components are optional and may not be installed. 
For more information about third-party products, see “About Third-Party 
Components” on page 75.

For more information about HYPERION_HOME and for a listing of the 
directories created, see “Files Installed in the HYPERION_HOME Directory” 
on page 40. 

● Installs Apache Tomcat Server, if you chose to install it during the 
Administration Server installation 

Apache Tomcat is installed to the HYPERION_HOME\common directory. For 
information about default ports for Apache Tomcat, see “Specifying 
Communication Ports for Apache Tomcat” on page 58. For information about 
deploying to a supported third-party application server, see “Deploying 
Administration Server on Third-Party Application Servers” on page 79.

● Installs and starts the MySQL database, if you chose to install it during the 
Administration Server installation 

MySQL is installed to the HYPERION_HOME\common directory. For 
information about deploying to a supported third-party relational database, see 
“Enabling Support for Third-Party Databases” on page 76.

On Windows platforms, MySQL is installed and started automatically as a 
Windows Service (Hyperion-MySQL-4.0.12). On UNIX platforms, MySQL 
is started in the background. If MySQL has been stopped for any reason, and 
if you want to use the Log Analyzer feature, you need to restart it. For 
instructions, see “Stopping and Restarting the MySQL Database” on page 57.

● Installs documentation files to the Administration Server computer

Documentation is installed in:

EASPATH\eas\deployments\Tomcat\4.1.30\webapps\easdocs

If you have deployed Administration Server on a supported third-party 
application server, the documentation is deployed on that application server 
and is not installed on Administration Server.

For more information about documentation, see “Documentation Installed” on 
page 41.

● On Windows, adds shortcuts to the Start menu 
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● Installs an uninstaller program

The uninstaller program is located in EASPATH\eas\uninstall 

For uninstallation instructions, see “Uninstalling Administration Services” on 
page 47.

● Installs and runs Essbase Deployment Server as a servlet in the Administration 
Server application server (Tomcat Apache by default)

This servlet is used exclusively for the Data Preview Grid feature. For more 
information about this feature, see Essbase Administration Services Online 
Help.

Note: For information about managing Essbase Deployment Servers through 
Administration Services Console, see Essbase Administration Services Online 
Help.

Files Installed in the EASPATH Directory
The directory where you install Administration Services is referred to as the 
EASPATH directory. The default for EASPATH is c:\hyperion on Windows 
platforms and /home/hyperion on UNIX platforms.

Table 7 describes the directories that the installer program creates for a typical 
(both server and console software) installation. 

Table 7: Directories Created in the EASPATH Directory During a 
Typical Installation 

Directory Description

eas Contains Administration Services readme file, 
documentation launch file, and their associated files

eas\console Contains Administration Services Console executable 
files, Java class files, and any temporary files created by 
the console

eas\deployments Contains application server files, documentation files, and 
files to support administration of Essbase Deployment 
Servers
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Files Installed in the HYPERION_HOME Directory
The Administration Services installer places components that might also be used 
by other Hyperion programs in a common location. This includes third-party 
products such as JRE as well as internal Hyperion components. The location for 
these components is defined in the system environment variable called 
HYPERION_HOME. The default location for HYPERION_HOME is  c:\hyperion on 
Windows platforms and /home/hyperion on UNIX platforms. Once defined, the 
location for HYPERION_HOME cannot be changed.

For more information about how the HYPERION_HOME environment variable is set 
or detected during installation, see “Installing Administration Services Software” 
on page 35.

eas\server Contains Administration Server executable files, 
relational database files, Java class files, and server locale 
files

eas\uninstall Contains files for uninstalling Administration Services

Table 7: Directories Created in the EASPATH Directory During a 
Typical Installation (Continued)

Directory Description
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Table 8 lists the files that are installed in the HYPERION_HOME\common directory 
with a default installation of Administration Services. Some common components 
are optional and may not be installed.

CAUTION: Do not manually move, delete, or overwrite the common 
components.

Documentation Installed
Documentation files are installed to Administration Server so that all console users 
can access documentation from Administration Services Console without needing 
to install documentation locally. If you have deployed Administration Server on a 
supported third-party application server, the documentation is deployed on that 
server. For information about supported third-party application servers, see 
“Deploying Administration Server on Third-Party Application Servers” on 
page 79.

All documentation components can be launched from the Administration Services 
Information Map.

Table 8: Directories Created in the HYPERION_HOME\common Directory 

Directory Description

appServers Contains Apache Tomcat Server files (optional 
during installation)

CSS Contains Hyperion Security Platform files

DBMS Contains MySQL database management system 
(DBMS) files (optional during installation)

HyperionLookAndFeel Contains installer user interface files

JDBC Contains Java Database Connectivity (JDBC) files

JRE Contains Java Runtime Environment (JRE) files

loggers Contains files for Hyperion Security Platform 
logging

XML Contains common XML components
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➤ To launch the Information Map in a Web browser, navigate to the EASPATH\eas 
directory and double-click the doc_launcher.htm file.

Note: On Windows platforms, if you chose to add shortcuts to the Start menu during 
installation, you can also launch the Information Map from the Start menu. Select Start > 
Programs > Hyperion Solutions > Essbase Administration Services > Information Map.

Browser Limitations

For best results, Hyperion recommends viewing Essbase Administration Services 
Online Help in Internet Explorer version 6.0 or later or in Netscape Navigator 
version 7.0 or later. Certain features of the help system, however, are not supported 
by Netscape Navigator. 

On UNIX platforms, if you use Netscape Navigator to view the help system, you 
must open Netscape before you attempt to launch the help system from the Help 
menu in Administration Services Console. 

Running Administration Server as a 
Windows Service

Running Administration Server as a Windows service enables you to start and stop 
it from the Windows Control Panel. Running Administration Server as an 
automatic service starts Administration Server as a service when you start 
Windows. This section contains the following topics:

● “Installing Administration Server as a Windows Service” on page 43

● “Adding Administration Server as a Windows Service” on page 43

● “Verifying That Administration Server Is Running as a Windows Service” on 
page 44

● “Stopping the Administration Server Windows Service” on page 44

● “Starting the Administration Server Windows Service” on page 44

● “Resetting the Administration Server Windows Service” on page 45

● “Removing the Administration Server Windows Service” on page 46
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Installing Administration Server as a Windows Service

➤ To install Administration Server as a Windows service:

1. During the Administration Services installation, when prompted to install 
Administration Server as a Windows service, select Yes.

2. After installing Administration Services, reboot the Windows server 
computer.

Adding Administration Server as a Windows Service
You can add Administration Server as a Windows service, even if it was not 
installed as a Windows service.

➤ To add Administration Server to the list of Windows services:

1. From a command prompt, navigate to the following directory:

EASPATH\eas\server\bin

2. Run the following command:

install_service.bat

Administration Services installs the Windows service as 
Hyperion-Essbase_Administration_Server Windows service. A message 
displayed in the command prompt window indicates that the service is 
installed.

3. Start the Hyperion-Essbase_Administration_Server Windows service.

See “Starting the Administration Server Windows Service” on page 44.

The Hyperion-Essbase_Administration_Server Windows service is set to start 
automatically each time you reboot.
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Verifying That Administration Server Is Running as a 
Windows Service

➤ To verify that Administration Server is running as an automatic Windows service 
after you reboot:

1. Select Start > Settings > Control Panel. 

2. Double-click Administrative Tools. 

3. Double-click Services. 

You see Hyperion-Essbase_Administration_Server in the list of services. The 
Startup (or Startup Type) field for the service should say Automatic, and the 
Status field should say Started.

Note: If the Startup field is blank or if it says Disabled or Manual, see “Resetting 
the Administration Server Windows Service” on page 45.

Stopping the Administration Server Windows Service

➤ To stop the Administration Server Windows service:

1. Select Start > Settings > Control Panel.

2. Double-click Administrative Tools.

3. Double-click Services.

The Services window is displayed. Hyperion-Essbase_Administration_Server 
is listed in the list of services.

4. Highlight, but do not double-click, the service name.

5. Select Action > Stop.

The Service Control message box is displayed briefly. After the message box 
is displayed, the Status field for Hyperion-Essbase_Administration_Server is 
blank.

Starting the Administration Server Windows Service
If you stop the Administration Server Windows service or if you have just added 
Administration Server as a Windows service, you can start the service from the 
Services dialog box of the Control Panel.
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➤ To start the Administration Server Windows service:

1. Select Start > Settings > Control Panel.

2. Double-click Administrative Tools.

3. Double-click Services.

The Services window is displayed. Hyperion-Essbase_Administration_Server 
is listed in the list of services.

4. Highlight, but do not double-click, the service name.

5. Select Action > Start.

The Service Control message box is displayed briefly when the Status field for 
Hyperion-Essbase_Administration_Server is Started.

Resetting the Administration Server Windows Service
When you install Administration Server as a Windows service, it is listed as 
Hyperion-Essbase_Administration_Server in the list of services. If someone 
disables the service or sets it to manual startup, you can reset Administration 
Server to start automatically.

➤ To reset Administration Server to start automatically:

1. Select Start > Settings > Control Panel.

2. Double-click Administrative Tools.

3. Double-click Services.

The Services window is displayed. Find 
Hyperion-Essbase_Administration_Server in the list of services.

4. Double-click Hyperion-Essbase_Administration_Server.

5. Set the service to log on automatically as a system account.

a. In the Hyperion-Essbase_Administration_Server Properties dialog 
box, select Automatic from the Startup type drop-down list.

b. In the Log On tab, select Local System account.



46 ■

Installing Administration Services

Essbase Administration Services Installation Guide

Removing the Administration Server Windows Service

➤ To remove Administration Server as a Windows service:

1. Stop the Hyperion-Essbase_Administration_Server Windows service. 

See “Stopping the Administration Server Windows Service” on page 44.

2. From a command prompt, navigate to the following directory:

EASPATH\eas\server\bin

3. Run the following command:

remove_service.bat

A message displayed in the command prompt window indicates that the 
service has been removed.

Selecting the ESSLANG Value
The Administration Services installer prompts you to select a value for the 
ESSLANG environment variable. ESSLANG points Administration Server to the 
correct Global C code page (installed in the EASPATH\eas\server\locale 
directory). The default value for ESSLANG is English (Latin1). 

The Administration Services installer provides a list of supported locales, 
displayed in abbreviated format: Language (code page), for example, 
English (Latin1). Once set, the ESSLANG environment variable 
value contains the full value for the locale (for example, 
English_UnitedStates.Latin1@Binary). 

ESSLANG must be the same on the Analytic Server computer and on the 
Administration Server computer. The ESSLANG value for a computer must agree 
with the encoding of the operating system of that computer.

Note: For important information about ESSLANG and Unicode applications on Analytic 
Server, see the Essbase Analytic Services Installation Guide.

On Windows, the ESSLANG value you select during installation creates or 
replaces the ESSLANG system environment variable with the selected locale. 
On UNIX, this setting exports the ESSLANG selection to the 
EASPATH/eas/server/bin/startEAS script. 
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On Windows, if ESSLANG is already set on the computer to which you are 
installing Administration Server, that value is selected by default in the installer. 
On UNIX, the installer always defaults to English (Latin1), even if ESSLANG 
is already set to a different value. You must select the same value as the existing 
ESSLANG setting when the installer prompts you; otherwise, your applications may 
fail to start.

For the full list of supported ESSLANG values, see Essbase Analytic Services 
Database Administrator’s Guide.

ESSLANG does not need to be set on the computer where Administration Services 
Console is installed, unless it is installed on the same computer as Administration 
Server. If you are installing only the console, the installer does not prompt you to 
set ESSLANG.

Uninstalling Administration Services
Administration Services provides a cross-platform uninstaller program that helps 
you to remove Administration Server and Administration Services Console from 
your system. If you are using the default application server, documentation files 
are also removed by the uninstaller.

The uninstaller program does not remove the following information:

● The common components that reside in the HYPERION_HOME\common 
directory

● Files used to store Administration Services user information (from the 
EASPATH\eas\storage\easusers directory)

● Log files that reside in the EASPATH\eas\server directory.

● Other files or directories that are created after installation

➤ To uninstall Administration Services:

1. If you want to retain Administration Services user information, export the 
users. 

See “Backing Up and Restoring User Information” on page 60.

2. If you are uninstalling Administration Server and you installed Administration 
Server as a Windows service, stop and remove the Administration Server 
Windows service.

See “Removing the Administration Server Windows Service” on page 46.
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3. Stop all instances of Administration Server and Administration Services 
Console.

4. Launch the uninstaller program for your platform.

Note: On Windows platforms, you can also uninstall from the Control Panel 
(Add/Remove Programs).

5. Follow the uninstall prompts.

6. After the uninstallation is complete, delete the EASPATH\eas directory.

Table 9: Administration Services Uninstaller Program

Platform Uninstaller Program

Windows EASPATH\eas\uninstall\uninstall.exe

UNIX EASPATH/eas/uninstall/uninstall
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4

Chapter

4
Upgrading to This Release

This chapter describes the process for upgrading from a previous release of 
Administration Services to this release.

● “Upgrading from Release 6.5.3 or Release 7.0” on page 49

● “Uninstalling Previous Releases” on page 51

Upgrading from Release 6.5.3 or Release 7.0
Use the following process to upgrade from Release 6.5.3 or Release 7.0 of 
Administration Services to this release:

1. Verify that you have all necessary software and documentation for this release.

See “Product Components” on page 23.

2. Decide how you want to deploy Administration Services. 

You can install Administration Services and Analytic Server on different 
computers or platforms. See “Deployment of Administration Services” on 
page 16.

3. Ensure that you have met all prerequisites.

See “Prerequisites” on page 23.

4. Confirm that your platform is supported by Administration Services and that 
system requirements are met for the computer on which you are installing. 

See “System Requirements” on page 24.
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5. Optional: Export user information so that you can migrate users to the new 
release: 

a. From the Administration Services Console window under the Essbase 
Administration Servers node, select the Administration Server name.

b. Right-click and select Export database to file.

c. In the Export Database dialog box, specify the location for the export 
file.

d. Click Export.

The user information is exported to the specified location in XML format, 
with sensitive data encrypted. The user information for the default 
administrator account is not exported.

6. Back up the directory used to store objects that are saved on Administration 
Server, such as MaxL scripts and partition definitions. Administration Server 
objects are stored in:

EASPATH\eas\storage

7. Stop Administration Server and Administration Services Console.

8. On Windows, stop and remove the MySQL embedded database service by 
running the appropriate file for your release:

● Release 6.5.3: 

EASPATH\eas\server\dbms\bin\stop_mysql.bat

● Release 7.0:

EASPATH\eas\server\dbms\bin\remove_EASMySql.bat

Note: On UNIX, MySQL is stopped when Administration Server is stopped and is 
removed when you uninstall.

9. Uninstall any previous releases of Administration Services.

See “Uninstalling Previous Releases” on page 51.

10. Delete one of the following directories:

● If uninstalling Release 6.5.3, delete the ARBORPATH\eas directory.

● If uninstalling Release 7.0, delete the EASPATH directory.
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11. Install this release of Administration Services. 

See “Installing Administration Services” on page 33.

12. Start Administration Services. 

See “Starting Administration Services” on page 53.

13. Optional: Import users from the previous release:

a. From the Administration Services Console window under the Essbase 
Administration Servers node, select the Administration Server name.

a. Right-click and select Import database from file.

b. In the Import Database dialog box, navigate to the location of the export 
file.

c. Select the exported file, and click Import.

User information is restored. Existing users are not overwritten.

14. Restore the directory that is used to store objects saved on Administration 
Server (see step 6 on page 50).

Uninstalling Previous Releases
If you have a previous release of Administration Services already installed, see 
“Upgrading from Release 6.5.3 or Release 7.0” on page 49 for instructions about 
uninstalling.

For information about uninstalling the current release, see “Uninstalling 
Administration Services” on page 47. 
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5

Chapter

5
Working with Administration 
Services

This chapter describes how to start and stop Administration Services and provides 
the access information that you need to connect for the first time.

● “Starting Administration Services” on page 53

● “Shutting Down Administration Services” on page 56

● “Stopping and Restarting the MySQL Database” on page 57

● “Specifying Communication Ports for Apache Tomcat” on page 58

● “Setting Up Users” on page 59

● “Backing Up and Restoring User Information” on page 60

● “Setting Up an SMTP Server” on page 60

Note: For instructions to start Analytic Servers, see “Running Analytic Servers, 
Applications, and Databases” in Essbase Analytic Services Database Administrator’s 
Guide.

Starting Administration Services
After you install Administration Services, start Administration Server and then 
Administration Services Console. 

Note: For troubleshooting information about starting Administration Services, see the 
eas_readme.htm file in the EASPATH\eas directory.

For information about how connections to Analytic Servers are established and how 
ports are established, see Essbase Administration Services Online Help.
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Starting Administration Server

Note: If Administration Server is installed and running as a Windows service, you 
cannot also start it manually because the default port number is already being used by 
the Windows service. If you try to start Administration Server manually, you will see an 
error message indicating that the port is in use. To view the procedure for changing a 
default port value, see “Specifying Communication Ports for Apache Tomcat” on 
page 58.

When you start Administration Server, ARBORPATH is set internally to the 
following location: 

EASPATH\eas\server

This internal setting overrides (but does not replace) the value for the ARBORPATH 
system environment variable, if it is set on the same computer. 

➤ To start Administration Server manually, launch one of the following files:

● On Windows platforms, launch

EASPATH\eas\server\bin\startEAS.exe 

Note: If you chose to add shortcuts to the Start menu during installation, you can 
start Administration Server from the Start menu (Start > Programs > Hyperion 
Solutions > Essbase Administration Services> Start Administration Server).

● On UNIX platforms, start Administration Server in the foreground or the 
background:

– Foreground:

From the EASPATH/eas/server/bin directory, type

./startEAS

– Background:

From the EASPATH/eas/server/bin directory, type

./startEAS & 

or

nohup ./startEAS & 

When Administration Server starts, a text-mode Agent process or DOS window is 
displayed.
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Starting Administration Services Console

➤ To start Administration Services Console:

1. Launch EASPATH\eas\console\bin\admincon.exe. 

Note: If you chose to add shortcuts to the Start menu during installation, you can 
start Administration Services Console from the Start menu (Start > Programs > 
Hyperion Solutions > Essbase Administration Services > Administration Console).

When Administration Services Console starts properly, the Essbase 
Administration Services Login dialog box is displayed.

2. In the Essbase Administration Services Login dialog box, perform the 
following steps:

a. Enter the Administration Server name. 

This is the name of the computer on which you installed Administration 
Server. 

Note: If the value for the Administration Server port has been changed from 
the default value, you must specify the new port value after the Administration 
Server name (for example, AdminServerName:9002). For more information 
about communication ports, see “Specifying Communication Ports for Apache 
Tomcat” on page 58.

b. Enter your Administration Server username. 

If you do not have this information, contact the Administration Services 
administrator. If you are connecting for the first time after installation, use 
the default username, admin. 

c. Enter your Administration Server password. 

If you do not have this information, contact the Administration Services 
administrator. If you are connecting for the first time after installation, use 
the default password, password.

The console is displayed with Enterprise View in the left frame and a blank 
workspace in the right frame. If you are starting Administration Services for 
the first time, the User Setup Wizard is displayed. For instructions, see 
“Setting Up Users” on page 59.
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Shutting Down Administration Services
The process for shutting down Administration Services is described in the 
following topics:

● “Closing Administration Services Console” on page 56

● “Stopping Administration Server” on page 56

Closing Administration Services Console

➤ To close Administration Services Console, from the console menu bar, select 
File > Exit.

You are prompted to save information, such as settings and modifications. 

In instances where your session has timed out but you still have open files that 
require action (for example, a report script), you are prompted to log back on to 
Administration Services Console before closing. You can change the timeout 
setting for Administration Services sessions. For more information on setting the 
timeout, see Essbase Administration Services Online Help.

Stopping Administration Server

➤ To stop Administration Server, launch one of the following files:

● On Windows platforms, launch

EASPATH\eas\server\bin\stopadminsvr.exe 

Note: If you chose to add shortcuts to the Start menu during installation, you can 
stop Administration Server from the Start menu (Start > Programs > Hyperion 
Solutions > Essbase Administration Services > Stop Administration Server).

● On UNIX platforms, launch

EASPATH/eas/server/bin/stopEAS 

Note: If you are using the middle-tier MySQL database, the database is not stopped 
when Administration Server is stopped. For more information, see “Stopping and 
Restarting the MySQL Database” on page 57.
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Stopping and Restarting the MySQL Database
If you choose to install the MySQL database, it is started during the installation. 
On Windows platforms, the database runs as a Windows service 
(Hyperion-MySQL-4.0.12). On UNIX platforms, the database runs in the 
background. The database is not stopped when you shut down Administration 
Server. 

➤ To stop the Hyperion-MySQL-4.0.12 service on Windows platforms, use the 
Windows Control Panel or enter the following string at a command prompt:

net stop “Hyperion-MySQL-4.0.12”

➤ To stop MySQL on UNIX platforms, run the following script:

HYPERION_HOME/common/DBMS/MySQL/4.0.12/bin/mysql_stop.sh

If MySQL has been stopped, and if you want to use the Log Analyzer feature, you 
must restart MySQL manually. 

➤ To restart MySQL on Windows platforms, use Windows Control Panel to restart 
the Hyperion-MySQL-4.0.12 service or enter the following string at a command 
prompt:

net start “Hyperion-MySQL-4.0.12”

➤ To restart MySQL on UNIX platforms, run the following script:

HYPERION_HOME/common/DBMS/MySQL/4.0.12/bin/mysql_start.sh

Note: To start MySQL, you must be logged on to the UNIX server on the account that 
was used to install Administration Server.
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Specifying Communication Ports for Apache 
Tomcat

Administration Services provides the following configurable communication 
ports for the default middle-tier application server (Apache Tomcat). If you choose 
to install Apache Tomcat, the installer program prompts you to configure the 
following ports:

● The startup port listens to commands from Administration Services Console. 
This port is established when Administration Server is started and is released 
when Administration Server is shut down. The default port is 9001.

If you change this port setting, you need to specify the new port value when 
you log in to Administration Services Console (for example, 
AdminServerName:9002).

● The shutdown port listens for a shutdown command when Administration 
Server is stopped. This port is released when Administration Server is shut 
down. The default port is 9005. For information about stopping, see “Stopping 
Administration Server” on page 56.

● The SSL HTTP connector port listens to commands from Administration 
Services Console. This port is established when Administration Server is 
started and is released when Administration Server is shut down. The default 
port number is 9443.

● The Warp connector port (Apache connector port) is used to connect Apache 
with Tomcat as the Apache servlet container. The port is established when 
Administration Server is started and is released when Administration Server 
is shut down. The default port number is 9008.

● If you choose to install the MySQL database, the default port number is 3306. 
You can change this port at installation time only. 

If a default port is already in use, you must specify another port value. 

➤ To change the default ports used by Apache Tomcat:

1. In a text editor, open the server.xml file located in the 
EASPATH\deployments\Tomcat\4.1.30\conf directory.

2. Referring to the default port numbers identified above, find the appropriate 
port number within server.xml and replace it with a new value.
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3. Save the server.xml file.

4. If Administration Server is running, shut it down.

5. Restart Administration Server. 

You must restart the Administration Server for the port settings to take effect.

See “Starting Administration Server” on page 54.

6. On Windows platforms, if you are running Administration Server as a 
Windows service, stop the service and start Administration Server manually. 

7. If you changed the port setting for the startup port, you need to specify the new 
port value after the Administration Server name (for example, 
AdminServerName:9002) when logging on to Administration Services 
Console.

Setting Up Users
Before other users can begin using Administration Services to manage Essbase, 
you must add users to Administration Server and populate each user’s Enterprise 
View with the appropriate Analytic Servers.

➤ To add users to Administration Server and populate each user’s Enterprise View:

1. From the Administration Services Console window, launch the User Setup 
Wizard by selecting Wizards > User Setup Wizard.

2. In the User Setup Wizard, follow the prompts to set up users for 
Administration Services, keeping in mind the following factors:

● If you connected using the default administrator information, change the 
password for the administrator account.

● If you need help while using the User Setup Wizard, click Help.

Note: Users can also edit their own list of Analytic Servers using the User Setup 
Wizard, the User Properties window, or the right-click menu off of the Essbase Analytic 
Servers node in Enterprise View.
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Backing Up and Restoring User Information
After you create Administration Services users and establish each user’s list of 
Analytic Servers, you should export user information so that you can restore if 
necessary.

➤ To back up (export) user information:

1. From the Administration Services Console window, under the Essbase 
Administration Servers node, select the Administration Server name.

2. Right-click and select Export users.

3. In the Export Users dialog box, specify the location for the export file.

4. Click Export.

The user information is exported to the specified location in XML format, 
with sensitive data encrypted. The user information for the default 
administrator account is not exported.

➤ To restore (import) user information:

1. From the Administration Services Console window, under the Essbase 
Administration Servers node, select the Administration Server name.

2. Right-click and select Import users.

3. In the Import Users dialog box, navigate to the location of the export file.

4. Click Import.

User information is restored. Existing users are not overwritten.

 Setting Up an SMTP Server
Simple Mail Transfer Protocol (SMTP) is a protocol for sending e-mail messages. 
To enable administrators to send e-mail messages directly from Administration 
Services Console to other administrators or to Hyperion Technical Support, an 
outgoing mail (SMTP) server must be specified on the Administration Server 
computer. When an administrator sends e-mail from Administration Services 
Console, the specified SMTP server is used to send the message to the receiver's 
e-mail client. 
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Specify an SMTP server in Administration Services Console on the Admin Server 
Properties window—Configuration tab. If an SMTP server is not specified, 
administrators cannot send e-mail from the console.

➤ To specify an outgoing mail server:

1. Start Administration Services.

See “Starting Administration Services” on page 53.

2. From the Administration Services Console window under the Essbase 
Administration Servers node, select the Administration Server name.

3. Right-click and select Edit properties.

4. In the Admin Server Properties window, select the Configuration tab.

5. In the E-mail Server area, enter the name of the SMTP server.

6. Click Apply and close the Admin Server Properties window.

For more information about setting up an SMTP server, see Essbase 
Administration Services Online Help.
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6

Chapter 

6
Implementing the Hyperion 
Security Platform

This chapter explains how to set up Analytic Services and Administration Services 
to use external authentication supplied by the Hyperion security platform. It 
includes the following topics:

● “About the Hyperion Security Platform” on page 63

● “Workflow for Implementing the Security Platform” on page 64

● “Selecting a Deployment Scenario” on page 68

About the Hyperion Security Platform
Using external authentication to manage user accounts provides the following 
benefits:

● The existing corporate structure of user accounts can be employed to reduce 
administrative overhead.

● Single sign-on between Analytic Services and other Hyperion products 
eliminates the need for users to log on multiple times with multiple usernames 
and passwords. 

This chapter assumes that you have a corporate authentication provider. The 
following providers are supported: 

● Windows NT LAN Manager

● Microsoft Active Directory

● An iPlanet or Novell LDAP Directory 
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You must configure Analytic Server and Administration Server to work with your 
authentication provider.

For more information about the Hyperion security platform, see the “Security 
Platform Reference” section of the Technical Reference. 

Workflow for Implementing the Security 
Platform

This topic describes the workflow for implementing the security platform for use 
with Administration Services:

1. Read the Security Platform Configuration documentation, located in the 
“Security Platform Reference” section of the Technical Reference. 

2. Decide how you will implement the security platform: from an application or 
from an application server.

Table 10 lists the Web servers/application servers that are supported, on each 
operating system, by the Hyperion security platform.

Table 10: Supported Web Servers/Application Servers by OS

Operating System Web/App Servers

Windows NT 4.0, sp 6a or higher IIS 4.x, Apache 2.0.43

Windows 2000 Server and Advanced 
Server, sp 3 or higher 

IIS 5.x, Apache 2.0.43

Windows 2003 IIS 6.x

Solaris 8 and 9 Apache 1.3.27

HP-UX 11i Apache 1.3.27
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3. Decide which of the supported authentication providers, on which platforms, 
to make available in the security realm. See Table 11.

Note: The tested and supported LDAP servers are: iPlanet 5.2, Novell eDirectory 
8.7, IBM Directory Server 5.1, and Domino LDAP 5.x and 6.0. iPlanet is now known 
as Sun[tm] Open Net Environment (Sun ONE).

4. Select a deployment scenario. 

The security platform can be implemented with Administration Services and 
Analytic Services in a variety of deployment scenarios. See sample 
deployment scenarios in “Selecting a Deployment Scenario” on page 68.

Table 11: Supported Authentication Providers and Platforms

Lightweight 
Directory 
Access 
Protocol 
(LDAP) 
version 3 
compatible 
directories

NT LAN 
Manager 
(NTLM)

Microsoft 
Active 
Directory 
2000

Microsoft 
Active 
Directory 
2003

Windows NT 
4.0, sp 6a or 
higher

X X X X

Windows 2000 
Server and 
Advanced 
Server, sp 3 or 
higher 

X X X X

Windows 2003 X X X X

UNIX X X - requires 
installation 
of Hyperion  
Remote 
Authenticati
on Module

X X
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5. Install Analytic Services. 

See the Essbase Analytic Services Installation Guide, particularly the topic 
“Installing the Hyperion Security Platform” in the “Performing Advanced 
Installation Tasks” chapter. The topic includes platform-specific information 
about setting up Java environment variables and about implementing other 
steps that the security platform requires.

6. Install Administration Services, as described in this book.

7. Create or edit the security platform XML configuration file, based on the type 
of external authentication directory. 

For detailed information about the configuration file, see “Configuring the 
Security Platform” in the Technical Reference, “Security Platform 
Reference.”

Sample XML configuration files are located in the following locations:

● essbase\bin\css_config.xml 

under the Analytic Services installation

● common\CSS\2.5.x\configuration\css-full.xml 

under the Hyperion home directory in Program Files.

8. Edit the Analytic Services essbase.cfg configuration file to point to the 
location of the XML configuration file. 

This procedure is described in detail in “Selecting the Authentication Module” 
in the Technical Reference, “Security Platform Reference.”

9. Edit the Administration Services file OlapAdmin.properties to point to 
the URL of the XML configuration file. 

The OlapAdmin.properties file is located in the eas\server directory of 
the Administration Services installation.

In the OlapAdmin.properties file, the reference to the XML configuration 
file can be to a file on the file system or to a URL; for example,

SECURITY_CONFIGURATION=file://srv1/net/essbase/bin/my.xml

SECURITY_CONFIGURATION=http://localhost:8080/config.xml
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SECURITY_CONFIGURATION=file:///c:/essbase/bin/config.xml

SECURITY_CONFIGURATION=file://localhost/c:/my.xml

Note: Use standard URL encoding whenever you refer to the XML configuration 
file. For example, the URL encoded value for a space is %20, so if the URL contains 
spaces, replace them with %20.

10. Using Administration Services Console, first create a user for Administration 
Services, and then create a user for Analytic Services. For both users, use the 
“Search” feature to ensure that each user exists in the external authentication 
repository. 

For information about creating users, see “Creating Users for External 
Authentication” on page 74. 

11. Using Administration Services Console, add the properly configured Analytic 
Server to the Administration Services user properties, and map the 
Administration Services user to the external Analytic Services user. 

You can use the User Setup Wizard or the Administration Server User 
Properties window. For detailed instructions, see “Creating Users on 
Administration Servers” in Essbase Administration Services Online Help.

Note: When mapping the user, you do not need to enter a password because the 
user is externally authenticated. 

12. Close and then reopen Administration Services Console.

13. Connect as the externally authenticated Administration Services user.

Note: Because all Hyperion products that use the security platform must point to the 
same XML configuration file, it is recommended that you keep the XML configuration 
file in the directory HYPERION_HOME\common\CSS\2.5.x\configuration.
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Selecting a Deployment Scenario
To select a deployment scenario, answer the following questions and then consider 
the sample deployment scenarios: 

● Which operating system will run Analytic Server?

● Which operating system will run Administration Services?

● Which authentication provider hosts the corporate user accounts?

● Will Analytic Server and Administration Server run on one computer or on 
separate computers? 

For descriptions of deployment scenarios for Analytic Server and 
Administration Server, see Essbase Administration Services Installation 
Guide.

Scenario 1: Analytic Server and Administration Services 
on Separate Computers, Using LDAP or Active Directory

The following figure shows deployment on separate computers:

Figure 5: Analytic Server and Administration Services on Separate Computers, 
Using LDAP
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The XML configuration file resides on the Analytic Server computer. The 
Analytic Server essbase.cfg file contains a reference to the file URL of the 
XML configuration; for example,

AUTHENTICATIONMODULE CSS file:///C:/essbase/bin/my.xml

The Administration Server OlapAdmin.properties file also contains a 
reference to the file URL of the XML configuration; for example,

SECURITY_CONFIGURATION=file://net/srvr1/essbase/bin/my.xml

Both Analytic Server and Administration Server can be installed on a supported 
UNIX or Windows platform. The directory server can be on UNIX, a Windows NT 
4.0 server, or a Windows 2000 server.

When deploying with LDAP, you can use a secure SSL connection as an option. 
Setting up the LDAP server to operate over SSL is vendor-specific; see your client 
LDAP administrator for information. 

To enable the security platform for SSL, you must configure the 
<authProtocol></authProtocol> elements in the XML configuration file. 
For detailed information about configuring this file, see “Configuring the Security 
Platform” in the Technical Reference, “Security Platform Reference.” 

If disk space and RAM permit, the directory server and Administration Server can 
be combined into one server. 

All supported LDAP scenarios have the following requirements:

● All users in the directory must have the same prefix, such as cn or uid. 

● All groups in the directory must have the same prefix, such as cn or ou. 

● Referrals between directories are not supported. 

● Users and groups in the directory should exist under nodes, such as 
ou=People and ou=Groups, for optimum retrieval performance.
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Scenario 2: Analytic Server and Administration Server on 
the Same Computer, Using LDAP or Active Directory

The following figure shows deployment on the same computer:

Figure 6: Analytic Server and Administration Server on the Same Computer, 
Using LDAP or Active Directory

The XML configuration file resides on the computer with Analytic Server and 
Administration Server. The Analytic Server essbase.cfg file and the 
Administration Server OlapAdmin.properties file contain pointers to the local 
file location of the XML configuration file.

Analytic Server and Administration Server can be installed on a supported UNIX 
or Windows platform. The directory server can be on UNIX, a Windows NT 4.0 
server, or a Windows 2000 server.

When deploying with LDAP, you can use a secure SSL connection as an option. 
Setting up the LDAP server to operate over SSL is vendor-specific; see your client 
LDAP administrator for more information. 

To enable the security platform for SSL, you must configure the 
<authProtocol></authProtocol> elements in the XML configuration file. 
For detailed information about configuring this file, see “Configuring the Security 
Platform” in the Technical Reference, “Security Platform Reference.” 
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All supported LDAP scenarios have the following requirements:

● All users in the directory must have the same prefix, such as cn or uid. 

● All groups in the directory must have the same prefix, such as cn or ou. 

● Referrals between directories are not supported. 

● Users and groups in the directory should exist under nodes, such as 
ou=People and ou=Groups, for optimum retrieval performance.

Scenario 3: Analytic Server, Administration Server, and 
Configuration on Separate Computers, Using LDAP or 
Active Directory

The following figure shows LDAP or Active Directory deployment with Analytic 
Server and Administration Server on separate computers, where the security 
platform configuration file is hosted on a separate Web server:

Figure 7: Analytic Server and Administration Server on Separate Computers, 
Using LDAP or Active Directory
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The XML configuration file resides on the Analytic Server computer. The 
Analytic Server essbase.cfg file contains a reference to the URL of the XML 
configuration; for example,

AUTHENTICATIONMODULE CSS http://websvr1:8080/my.xml

The Administration Server OlapAdmin.properties file also contains a 
reference to the URL of the XML configuration; for example,

SECURITY_CONFIGURATION=http://websvr1:8080/my.xml

Analytic Server and Administration Server can be installed on a supported UNIX 
or Windows platform. The directory server can be on UNIX, a Windows NT 4.0 
server, a Windows 2000 server, or a Windows 2003 server.

When deploying with LDAP, you can use a secure SSL connection as an option. 
Setting up the LDAP server to operate over SSL is vendor-specific; see your client 
LDAP administrator for more information. 

To enable the security platform for SSL, you must configure the 
<authProtocol></authProtocol> elements in the XML configuration file. 
For detailed information about configuring this file, see “Configuring the Security 
Platform” in the Technical Reference, “Security Platform Reference.” 

All supported LDAP scenarios have the following requirements:

● All users in the directory must have the same prefix, such as cn or uid. 

● All groups in the directory must have the same prefix, such as cn or ou. 

● Referrals between directories are not supported. 
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Scenario 4: UNIX Analytic Server and Administration 
Server on the Same Computer, Using NT LAN Manager

The following graphic shows NT LAN Manager deployment with Analytic Server 
and Administration Server on a single UNIX computer:

Figure 8: UNIX Analytic Server and Administration Server on the Same Computer, 
Using NT LAN Manager

In this scenario, Analytic Server on UNIX needs to authenticate users from a 
Windows NT LAN Manager domain controller. The Hyperion Remote 
Authentication Module is required because the external authentication mechanism 
depends on the NTLM support library file (css-2_5_x.dll) for NTLM 
authentication, and dlls are not supported on UNIX. 

You can obtain the Remote Authentication Module from the Hyperion Download 
Center or from the Hyperion Hub CD. Download the compressed installation 
.exe file and follow the prompts.

Note: The Remote Authentication Module enables communication between NT LAN 
Manager and UNIX-based applications. When Analytic Server is installed on Windows 
platforms, the Remote Authentication Module is not required, unless you want to link 
domains that do not have trust relationships.

The XML configuration file resides on the computer with Analytic Server and 
Administration Server. The Analytic Server essbase.cfg file and the 
Administration Server OlapAdmin.properties file contain pointers to the local 
file location of the XML configuration file. 
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Other Deployment Scenarios
Many variations are possible from the deployment scenarios pictured in the 
preceding sections, because multiple authentication providers can be used. Several 
other scenarios are described in the Technical Reference, in the “Security Platform 
Reference” section, under “Security Platform Deployment Scenarios.” Because 
those scenarios do not mention Analytic Server or Administration Server 
specifically, please replace occurrences of “Hyperion Application” or 
“Application Server” with whatever combination of Analytic Server and 
Administration Server you are deploying.

Creating Users for External Authentication
The external user must be created twice, once for Administration Services and 
once for Analytic Services. Then you map the Administration Services user to the 
Analytic Services user. For detailed instructions, see “Creating Users on 
Administration Servers” and “Creating Users on Administration Servers” in 
Essbase Administration Services Online Help.

The user name must already exist in the external authentication repository. For 
example, if the Windows NT domain login name for user John Doe is jdoe, then 
you must create the user as jdoe. For LDAP or Active Directory, create the user 
names as specified by the <loginattribute></loginattribute> element in 
the security platform XML configuration file. For example, if the login attribute is 
configured as follows:

<loginattribute>cn</loginattribute>

then you must create users using the format of the Common Name attribute in the 
LDAP or Active Directory store.

Note: External users must be created with valid Analytic Services user names. For 
example, if the external directory contains user names with characters that Analytic 
Services does not allow, you must make changes to the names in the external directory. 
As an alternative, if Active Directory or LDAP is being used, you can change the login 
attribute in the XML configuration file so that another version of the name is used.

For information about creating external users with MaxL, see the “Security 
Platform Reference” section of the Technical Reference, under “MaxL Statements 
for External User Management.”
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7

Chapter 

7
Configuring Third-Party 
Components

This chapter explains how to configure third-party components that are not 
installed with Administration Services. It includes the following topics:

● “About Third-Party Components” on page 75

● “Enabling Support for Third-Party Databases” on page 76

● “Deploying Administration Server on Third-Party Application Servers” on 
page 79

About Third-Party Components
Administration Services requires the following third-party components:

● A relational database management system (RDBMS)

● An application server

● Java Runtime Environment

By default, all the components that you need to run Administration Services are 
automatically installed by the Administration Services installer program. This 
release also supports the substitution of certain third-party products within the 
existing framework. If you plan to substitute the default components with 
supported third-party products, you can choose not to install the default 
components during installation.

Administration Services is a Java application and therefore requires a Java 
Runtime Environment (JRE) to execute the program. This release requires JRE 
version 1.4.1 and installs this version automatically on all platforms. 
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Enabling Support for Third-Party Databases
This release supports the following relational databases:

● MySQL 4.0.12PRO

● Oracle 8i and 9i

● IBM DB2 7.2 and 8.1

The relational database that you choose is used only to store Log Analyzer 
information. For more information about Log Analyzer, see Essbase 
Administration Services Online Help.

By default, the Administration Server installation automatically installs, 
configures, and starts the MySQL database. For other supported databases, you 
can specify which database to use and provide configuration information for the 
database during installation. The installer prompts you for the database name/SID, 
host name, port number, and user ID. You can also modify configuration 
information manually after installation, as described in the sections below.

For more information about the MySQL database, see “Installing Administration 
Services Software” on page 35.

Note: Third-party databases do not have to be installed on the same computer as 
Administration Server. 

Configuring an Oracle Database
Follow this procedure if you need to modify configuration information for the 
database after installation.

➤ To enable Oracle support:

1. In Oracle, create an Oracle user with permissions to create tables.

2. Navigate to EASPATH\eas\server and back up the dao.properties file.

Note: The directory where you install Administration Services is referred to as the 
EASPATH directory.
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3. Copy the contents of the dao.properties.oracle file into the 
dao.properties file.

4. In a text editor, open the dao.properties file and replace the following 
values:

● Replace eas.user and eas.password with the user connection values 
for the Oracle user created in step 1.

● Replace HOSTNAME with the hostname where Oracle is currently running 
and replace SID_NAME with the Oracle SID to be connected. Both of these 
values are Oracle-specific.

5. Optional: Replace port number 1521 with the port number for the Oracle 
database.

Note: If Oracle is running on the default port, you can skip this step and proceed 
to the next step.

6. Navigate to EASPATH\eas\server\dbms and run the InitDB.exe file. 
This file creates the required tables in Oracle. 

Tip: You can ensure that the tables are created correctly by viewing the 
InitDB.log file.

7. Restart Administration Server and Administration Services Console.

See “Starting Administration Services” on page 53.

Configuring an IBM DB2 Database
Follow this procedure if you need to modify configuration information for the 
database after installation.

➤ To enable IBM DB2 support:

1. In DB2, create a DB2 user with permissions to create tables.

2. Navigate to EASPATH\eas\server and back up the dao.properties file.

Note: The directory where you install Administration Services is referred to as the 
EASPATH directory.



78 ■

Configuring Third-Party Components

Essbase Administration Services Installation Guide

3. Copy the contents of the dao.properties.db2 file into the 
dao.properties file.

4. In a text editor, open the dao.properties file and replace the following 
values:

● Replace eas.user and eas.password with the user connection values 
for the DB2 user created in step 1.

● Replace HOSTNAME with the hostname where DB2 is currently running 
and replace DB_NAME with the DB2 database name.

CAUTION: The DB2 database name must be uppercase. For example, 
DBNAME.

5. Optional: Replace port number 50000 with the port number for the DB2 
database.

Note: If DB2 is running on the default port, you can skip this step and proceed to 
the next step.

6. Navigate to EASPATH\eas\server\dbms and run the InitDB.exe file. 
This file creates the required tables in DB2. 

Tip: You can ensure that the tables are created correctly by viewing the 
InitDB.log file.

7. Restart Administration Server and Administration Services Console.

See “Starting Administration Services” on page 53.



Deploying Administration Server on Third-Party Application Servers

7

■ 79Essbase Administration Services Installation Guide

Changing the JDBC Password
In some cases, it might be necessary to change the JDBC password without 
connecting to Administration Server.

➤ To change the JDBC password:

1. In a text editor, navigate to the EASPATH\eas\server directory and open the 
dao.properties file.

Note: The directory where you install Administration Services is referred to as the 
EASPATH directory.

2. Change the value of the eas.password field in the dao.properties file. 
The new password will be in an unencrypted format. 

3. Start Administration Services.

When Administration Services is started, Administration Server finds and 
encrypts the unencrypted password in the dao.properties file.

Deploying Administration Server on Third-Party 
Application Servers

This release supports the following application servers:    

● Apache Tomcat Server 4.1.30

● BEA WebLogic Server 8.1

● IBM WebSphere Application Server 5.1

By default, the Administration Server installation automatically installs and 
configures Apache Tomcat Server. If you decide to use a supported third-party 
server, you must manually install it and configure it to work with Administration 
Server. For more information about Apache Tomcat, see “Installing 
Administration Services Software” on page 35.
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Deploying on a WebLogic Server

➤ To deploy Administration Server on a WebLogic Server running on Windows or 
UNIX:

1. If it is not already installed, install WebLogic Server.

2. Install Administration Server to the computer hosting WebLogic Server.

3. Follow the steps below to create a domain in WebLogic Server:

a. Launch the WebLogic Configuration Wizard:

● On Windows platforms, launch: 

weblogic81\common\bin\config.cmd

● On UNIX platforms, launch: 

weblogic81/common/bin/config.sh

b. Accept the defaults and click Next until you reach the Configure 
Administrative Username and Password panel.

c. Enter the username and password (for example, enter eas for the 
username and password for the password).

d. In the Configure Server Start Mode and Java SDK panel, choose either 
development mode or production mode. Select the default SDK value.

e. In the bottom-right corner of the Create WebLogic Configuration 
panel, rename the configuration, for example, to easdomain.

f. Click Create.

4. Navigate to the following location:

WEBLOGIC_INSTALLDIR\user_projects\domains\easdomain

5. Follow the configuration steps described next for your platform:

Note: The directory where you install WebLogic is referred to as 
WEBLOGIC_INSTALLDIR. Substitute the value of WEBLOGIC_INSTALLDIR 
from your site.

The directory where you install Essbase Administration Services is referred to as 
EASPATH. Substitute the value of EASPATH from your site. The default is 
c:\hyperion on Windows and /home/hyperion on UNIX.
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For Windows platforms: 

a. From the WEBLOGIC_INSTALLDIR\user_projects\domains\
easdomain directory, open the following file:

startweblogic.cmd

b. Insert the following text after “@REM Call WebLogic Server”:

● set PATH=EASPATH\eas\server\bin;%PATH% 

For example:

set PATH=c:\hyperion\eas\server\bin;%PATH%

This ensures that all the .dll files are retrieved from the correct 
location.

● set JAVA_OPTIONS=-DEAS_HOME=EASPATH 

For example:

set JAVA_OPTIONS=-DEAS_HOME=c:\hyperion 

This ensures that all Administration Services-related files are 
retrieved from the correct location.

● set ARBORPATH=EASPATH\eas\server 

For example:

set ARBORPATH=c:\hyperion\eas\server

● set ESSLANG=ESSLANGvalue

For example, with an English ESSLANG value:

set ESSLANG=English_UnitedStates.Latin1@Binary
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For UNIX platforms: 

a. From the WEBLOGIC_INSTALLDIR/user_projects/domains/
easdomain directory, open the following file:

startWebLogic.sh

b. Add the following text:

● For Solaris and Linux:

LD_LIBRARY_PATH=EASPATH/eas/server/bin:
$LD_LIBRARY_PATH

● For HP-UX:

SHLIB_PATH=EASPATH/eas/server/bin:$SHLIB_PATH

● For AIX:

LIBPATH=EASPATH/eas/server/bin:$LIBPATH

● For all UNIX platforms:

– JAVA_OPTIONS=”-DEAS_HOME=EASPATH”

This ensures that all Administration Services-related files are 
retrieved from the correct location.

– ARBORPATH=EASPATH/eas/server

– ESSLANG=ESSLANGvalue

For example, with an English ESSLANG value:

ESSLANG=English_UnitedStates.Latin1@Binary

6. Start WebLogic Server. To do so, execute startweblogic.cmd (Windows) 
or startWebLogic.sh (UNIX).
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7. Connect to the WebLogic administration console using the following URL: 

http://machineName:7001/console

By default, WebLogic runs on port 7001 on machineName; if the port is 
different, specify the appropriate port value when connecting.

If prompted for a username and password, provide the username and password 
specified in step 3c.

Note: On Windows, if you are accessing the WebLogic administration console 
locally, you can start the administration console using the Windows Start menu. 
You can also run the administration console on Windows to connect to WebLogic 
Server on UNIX.

8. Follow the steps below to deploy Administration Services for your platform:

For Windows:

a. From the WebLogic Server Admin Console, select Deployments > Web 
Application Modules.

b. Click Deploy a new Web Application Module.

c. Click upload your file and then click Browse. 

d. Navigate to the following directory:

EASPATH\eas\deployments\tomcat\4.1.30\webapps

Where EASPATH is the directory to which Essbase Administration 
Services is installed. The default is c:\hyperion on Windows and 
/home/hyperion on UNIX.

e. Select the eas.war file, and then click Open and Upload.

Note: If you are accessing WebLogic remotely, you must first copy the .war 
file to your local machine and then browse to the appropriate local directory to 
select the .war file.
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f. Navigate to myserver > upload, select eas.war, and click Target 
Module and later on Deploy.

After a brief wait, you will see Administration Server messages in the 
WebLogic Server window. These messages indicate that Administration 
Services is deployed and ready to be used. By default, WebLogic runs on port 
7001; therefore, use machineName:7001 when connecting to Administration 
Server.

For UNIX:

a. From the WebLogic Server Admin Console, select Deployments > Web 
Application Modules.

b. Click Deploy a new Web Application Module.

c. Browse to the following directory:

EASPATH\eas\deployments\tomcat\4.1.30\webapps

Where EASPATH is the directory to which Essbase Administration 
Services is installed. The default is c:\hyperion on Windows and 
/home/hyperion on UNIX.

Note: If you are accessing WebLogic remotely, you must first copy the .war 
file to your local machine and then browse to the appropriate local directory to 
select the .war file.

d. Select the eas.war file, and then click Target Module.

e. On the next screen, click Deploy.

After a brief wait, you will see Administration Server messages in the 
WebLogic Server window. These messages indicate that Administration 
Services is deployed and ready to be used. By default, WebLogic runs on port 
7001; therefore, use machineName:7001 when connecting to Administration 
Server.
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9. Repeat step 8 on page 83 to deploy Administration Services documentation 
(easdocs.war) and the Deployment Services servlet (eds.war), selecting 
the appropriate .war file from the same location as eas.war.

Note: The Deployment Services servlet (eds.war) is used only for the Data 
Preview Grid feature in Administration Services Console. If you do not plan to use 
this feature, you do not need to deploy this servlet.

Other tasks such as undeploying Administration Services, redeploying 
Administration Services, and changing the default port number can also be 
accomplished using the WebLogic Server Admin Console.

Deploying on a WebSphere Application Server
To deploy Administration Server on a WebSphere Application Server running on 
Windows or UNIX:

1. If it is not already installed, install WebSphere Application Server.

2. Install Administration Server to the computer hosting WebSphere Application 
Server.

3. Follow the configuration steps described next for your platform:

For Windows:

a. Back up the SetupCmdLine.bat file that is located in the \bin 
directory where WebSphere is installed; for example:

c:\program files\websphere\appserver\bin

b. In the original SetupCmdLine.bat file, edit the WAS_PATH entry by 
prepending the location with the installed Administration Server \bin 
directory, for example:

SET WAS_PATH=c:\hyperion\eas\server\bin;{original 
information}

The example above assumes that Administration Services is installed in 
c:\hyperion.



86 ■

Configuring Third-Party Components

Essbase Administration Services Installation Guide

c. In the original SetupCmdLine.bat file, set ARBORPATH as follows:

SET ARBORPATH=c:\hyperion\eas\server

The example above assumes that Administration Services is installed in 
c:\hyperion.

d. In the original SetupCmdLine.bat file, set ESSLANG, using the 
ESSLANG value that was used when Administration Server was installed 
on the system:

SET ESSLANG=ESSLANGvalue

For example, with an English ESSLANG value:

SET ESSLANG=English_UnitedStates.Latin1@Binary

e. Save the SetupCmdLine.bat file and close it.

For UNIX:

a. Back up the setupCmdLine.sh file that is located in the /bin directory 
where WebSphere is installed; for example

/vol1/websphere/AppServer/bin/setupCmdLine.sh

b. In the original setupCmdLine.sh file, under the appropriate section for 
your platform, edit the WAS_LIBPATH by prepending the location with the 
installed Administration Server /bin directory, for example:

WAS_LIBPATH=/vol1/Hyperion/eas/server/bin:{original 
information}

The example above assumes that Administration Services is installed in 
/vol1/Hyperion.

c. In the original setupCmdLine.sh file, set ARBORPATH as follows:

export ARBORPATH=/vol1/Hyperion/eas/server

The example above assumes that Administration Services is installed in 
/vol1/Hyperion.
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d. In the original setupCmdLine.sh file, set ESSLANG using the ESSLANG 
value that was used when Administration Server was installed on the 
system:

export ESSLANG=ESSLANGvalue 

For example, with an English ESSLANG value:

export ESSLANG=English_UnitedStates.Latin1@Binary

e. Save the setupCmdLine.sh file and close it.

4. Start WebSphere Application Server.

Using a command shell, go to the following directory:

WEBSPHERE_INSTALLDIR/AppServer/bin

Where WEBSPHERE_INSTALLDIR is the location where WebSphere is 
installed. 

From this directory in the command shell, type the following command:

On Windows: 

startServer server1

On UNIX: 

./startServer.sh server1

5. Launch the WebSphere Administrative Console, using the following URL:

http://machineName:9090/admin

By default, WebSphere runs on port 9090 on machineName; if the port is 
different, specify the appropriate port value when connecting.

Note: If you are prompted to log in, you do not need to supply a user ID. Leave this 
field blank and click OK.
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6. Follow the steps below to define the location of the Administration Services 
installation. If a referenced link or button is not visible, scroll until it is 
displayed.

a. Under the Servers node, select Application Servers.

b. Click server1.

c. Under Additional Properties, select Process Definition.

d. Under Additional Properties, select Java Virtual Machine.

e. Under General Properties, for Generic JVM Arguments, enter the 
following information for your platform:

For Windows:

-DEAS_HOME=c:\hyperion -Dorg.apache.xerces.xni.
parser.XMLParserConfiguration=org.apache.xerces.parsers.
StandardParserConfiguration

The example above assumes that Essbase Administration Services is 
installed in c:\hyperion.

For UNIX:

-DEAS_HOME=/vol1/Hyperion -Dorg.apache.xerces.xni.
parser.XMLParserConfiguration=org.apache.xerces.parsers.
StandardParserConfiguration

The example above assumes that Essbase Administration Services is 
installed in /vol1/Hyperion.

Note: All information starting with “-Dorg.apache...” in the examples 
above must be entered exactly as shown, all as one entry. Any typing error will 
result in WebSphere not starting properly.

f. Under the General Properties table, click Apply.

g. From the toolbar, click Save.

h. Under Save to Master Configuration, click Save.



Deploying Administration Server on Third-Party Application Servers

7

■ 89Essbase Administration Services Installation Guide

7. Follow the steps below to install Administration Services as a new WebSphere 
application:

a. Under the Applications node, select Install New Application.

b. Choose one of the following steps, depending on the location of the 
eas.war file:

● If your browser and the eas.war file are on the same machine, select 
Local path and browse to and select the eas.war file in the 
following directory:

For Windows:

c:\hyperion\eas\deployments\tomcat\4.1.30\webapps
\eas.war

The example above assumes that Administration Services is installed 
in c:\hyperion.

For UNIX:

/vol1/Hyperion/eas/deployments/Tomcat/4.1.30/
webapps/eas.war 

The example above assumes that Administration Services is installed 
in /vol1/Hyperion.

Note: The WebSphere server may be on another machine.

● If the eas.war file resides on the machine running the WebSphere 
server and if your browser is on a different machine, select Server 
path and enter the absolute path to the location of the eas.war file 
on the server machine.

c. For Context Root, enter /eas (you will need to remember this later when 
you connect).

d. Click Next.

e. Accept all defaults and click Next or Continue until the final installation 
screen displays.
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f. Click Finish.

g. Click Save to Master Configuration.

h. Click Save.

8. Repeat step 7 on page 89 to deploy Administration Services documentation 
and the Deployment Services servlet, making the following modifications:

● To deploy documentation, select the easdocs.war file from the same 
location as eas.war. For the Context Root, enter /easdocs.

● To deploy the Deployment Services servlet, select the eds.war file from 
the same location as eas.war. For the Context Root, enter /eds.

Note: The Deployment Services servlet (eds.war) is used only for the Data 
Preview Grid feature in Administration Services Console. If you do not plan to use 
this feature, you do not need to deploy this servlet.

9. After everything is installed, stop WebSphere Application Server and then 
restart it.

Connecting to WebSphere Application Server Through 
Administration Services Console

1. To start Administration Services Console on a WebSphere Application Server, 
launch Administration Services Console. 

2. In the Essbase Administration Services Login dialog box, type the 
following in the Administration Server text box:

machineName:9080/eas

Note: The default port number that is used by WebSphere Application Server is 
9080. If you are using a different port number than the default number, use that 
number instead to connect to WebSphere Application Server.
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removing the Administration Server Windows 

service, 46
requirements, system, 23
resetting the Administration Server Windows 

service, 45

resolution (screen), recommended, 29
restarting MySQL, 57
restoring user information, 60
running Administration Server as a Windows service, 
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S
screen resolution, recommended, 29
security platform

deployment scenarios, 68
described, 63
sample XML config files, 66
workflow for implementing, 64

security, backing up, 60
server names, 55
SERVER.XML file, port settings, 58
servlet engine, 79
session timeout, 56
setting up

an SMTP server, 60
users, 59

shortcuts on Start menu, 38
shutdown connector port, 58
SMTP server, setting up, 60
Solaris

installing on, 35
setting environment before installation, 23
starting Administration Server, 54
supported versions, 25
system requirements, 26

specifying communication ports, 58
SSL HTTP connector port, 58
startEAS (UNIX), 54
STARTEAS.EXE, 54
starting

Administration Server, 54
Administration Services Console, 55
Analytic Servers, 53
MySQL, 57
the Administration Server Windows service, 44
User Setup Wizard, 59

startup connector port, 58
STOPADMINSVR.EXE, 56
stopeas file (UNIX), 56
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stopping
Administration Services, 56
MySQL, 57
the Administration Server Windows service, 44

support matrix
Analytic Server releases, 24
authentication providers, 65
Deployment Server releases, 25
platform support, 25, 29

system requirements
Administration Server, 26
Administration Services Console, 29

T
technical support, xii
third-party products, 15

configuring, 75
installed with Administration Services, 75

threads, Administration Server, 27
timeout for session, 56
Tomcat Server

default ports, 58
version supported, 79

U
uninstalling Administration Services, 47, 51
UNIX

installing on, 35
launching installers, 35
setting environment before installation, 23
starting Administration Server, 54
system requirements, 26

upgrading Administration Services, 49
user name for admin account, 55
User Setup Wizard, launching, 59
users

adding, 59
backing up, 60
migrating from 6.5.3 or 7.0, 49

W
Warp connector port, 58
web server installed, 79
WebLogic Server

deploying Administration Server on, 80
prerequisite, 23
version supported, 79

WebSphere Application Server
deploying Administration Server on, 85
prerequisite, 23
version supported, 79

Windows
installing on, 35
Start menu, 38
starting Administration Server, 54
supported versions, 25, 29
system requirements, 26

Windows NT LAN Manager, 63
Windows service

running Administration Server as, 42
running MySQL as, 38

X
XWindows, launching installers in, 35
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